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ABSTRACT 

ISARLAB ("Inverse Synthetic Aperture Radar Laboratory") is a computer program 
designed as a research and training tool for those interested in the field of radar 
imaging. The system runs under MATLAB and is capable of simulating the radar 
returns from complex targets such as ships and aircraft, and processing these to form 
high range resolution (HRR) profiles and inverse synthetic aperture radar (BAR) 
images. In addition to simulating various radars and targets in realistic scenarios, 
ISARLAB can accept and process experimentally collected radar data. This document 
represents the combination of a Reference Guide and a User's Guide to the software 
package, as well as providing a brief introduction to radar imaging. 
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ISARLAB - Inverse Synthetic Aperture Radar 
Simulation and Processing Tool 

Executive Summary 

Inverse Synthetic Aperture Radar (ISAR) imaging is a relatively mature technique for 
generating 2-dimensional high resolution maps or images of target scattering. These 
images have the potential to allow the target of interest to be distinguished from other 
types of similar targets (i.e. the classification problem). ISAR images of all categories of 
vehicles (aircraft, ships and land vehicles) have been produced, but the technique has 
found significant military application in airborne maritime surveillance. This is 
predominantly because the rotational motions of roll, pitch and yaw induced on a ship 
by the sea can be substantial and thus provide a ready mechanism by which Doppler 
distributions across the target's structure can be consistently measured. The resulting 
2-D image is a projection of the target's scattering centres onto a range versus Doppler 
grid, where the projection plane is defined as being parallel to the radar line-of-sight 
range vector and perpendicular to the effective axis of rotation of the target. To 
illustrate this effect, a ship undergoing only roll motion will produce an end-on 
projection, a pitching ship will generate an elevation view and a yawing ship will yield 
a plan image. 

In reality ships undergo a combination of roll, pitch and yaw motions that yield a 
complex and continually changing effective axis of rotation. The resulting ISAR 
images can therefore be a multitude of visually unusual oblique projections. This leads 
to the challenge of training radar operators to understand the images acquired by the 
radar and subsequently, to be able to interpret them sufficiently to perform the 
classification task. 

The Australian Department of Defence is currently in the process of acquiring a new 
radar system as part of a comprehensive upgrade to the Royal Australian Air Force 
(RAAF) squadron of P-3C Orion maritime surveillance aircraft. The radar, being 
supplied by Elta of Israel, contains among other features, range profiling and ISAR 
imaging modes. This will be the first radar in the Australian Defence Force (ADF) 
inventory to incorporate a high resolution imaging capability, which means that 
training of radar operators in the effective use of this new technology is a significant 
issue. Ideally, training would be conducted using an extensive database of imagery 
collected from the operational radar. However, before the system enters routine 
service and begins to collect imagery, this database will not be available. One solution 
to the problem of insufficient ISAR image data for training is to generate synthetic 
data. 



The Surveillance Systems Division (SSD) of the Defence Science and Technology 
Organisation (DSTO) has developed a software tool for simulating radar returns and 
processing them to form range profiles and ISAR images. This tool, called ISARLAB, 
allows the user to define the scenario to be simulated using models for the radar 
waveform, the radar and target geometry, the target motions and, most importantly, 
the target scattering. Generation of quality target scattering models is key to the 
degree of realism which can be achieved with the system. The approach taken is to 
generate a point scatterer model for the target of interest from the results of an in- 
house developed electromagnetic prediction code called GSC (General Scattering 
Code). 

The problem with the whole task of ISAR image simulation now becomes one of 
producing sufficiently detailed CAD models of the targets of interest for input to GSC. 
Although this problem is not technologically challenging, the job of constructing high 
fidelity CAD models requires considerable effort and/or expense. One remaining 
question, however, is the degree of model accuracy needed to produce ISAR images 
with sufficient realism for the purpose of radar operator training. This requirement 
will also impact on the number of point scatterers needed in the model, and therefore 
on the computation time required by ISARLAB. This number is not known at this 
stage, but it appears that models with a few hundred point scatterers will be 
acceptable. Work is continuing in this area and validation will be achieved by a 
comparative analysis using real ISAR imagery. 

In summary, this document represents the combination of a Reference Guide and a 
User's Guide to the ISARLAB software package, as well as providing a brief 
introduction to radar imaging theory. It is believed that ISARLAB will prove beneficial 
to radar operator training by helping to develop an understanding of radar imaging 
mechanisms and the strengths and weaknesses of high resolution radar technology in 
an operational role. 



Authors 

Brett Haywood 
Surveillance Systems Division 

Brett Haywood received a B.E.(Hons.) degree in 1984 and a 
M.Eng.Sc. degree in 1988, both from the James Cook 
University of North Queensland. During this time he also 
worked as a tutor and part-time lecturer in the Department 
of Electrical and Electronic Engineering at James Cook 
University. Since 1988 he has been with the Surveillance 
Systems Division of the Defence Science and Technology 
Organisation (DSTO), where he now holds the position of 
Senior Research Scientist. Also from 1988 he studied for a 
PhD degree at the University of Newcastle, which was 
awarded in 1992. In 1989-90 he spent a long term attachment 
of 9 months at the Royal Signals and Radar Establishment 
(RSRE, now part ofDERA) in Malvern, England working on 
ISAR imaging techniques, immediately followed by 6 
months at the Naval Ocean Systems Center (NOSC, now 
SPA WAR) in San Diego, California investigating ultra wide 
band radar and ISAR imaging. His research interests 
include digital signal processing radar imaging (SAR and 
ISAR), foliage penetration radar and automatic target 
recognition. 

Ross Kyprianou 
Surveillance Systems Division 

Ross Kyprianou graduated from the University of Adelaide 
in 1983 with a Bachelor of Science majoring in Mathematical 
Physics and Pure Mathematics. He later completed a 
Postgraduate Diploma in Computer Science from the same 
university in 1985. From 1985 to 1990 he held various 
positions in Information Technology in the Australian 
government. Since 1990 he has worked in the Surveillance 
Systems Division of the Defence Science and Technology 
Organisation (DSTO) as a software engineer in the areas of 
ISAR imaging radar cross section (RCS) studies and 
automatic target recognition. 



Carmine Fantarella 
Surveillance Systems Division 

Carmine Fantarella received a B.E. (Hons) degree in 1996 
from the University of Adelaide. He has been with the 
Surveillance Systems Division of the Defence Science and 
Technology Organisation (DSTO) since 1997 as a 
Professional Officer working on ISAR signal processing and 
target classification, including software design and 
implementation for an airborne real-time ISAR processor. 

James McCarthy 
Surveillance Systems Division 

James McCarthy received a B.E. (Hons) degree in 1995 from 
the University of Adelaide. He has been with the 
Surveillance Systems Division of the Defence Science and 
Technology Organisation (DSTO) since 1995 as a 
Professional Officer. There he has worked in maritime 
surveillance radar on ISAR signal processing and target 
classification, airborne radar system software design and 
implementation of maritime surveillance radar modes. 



DSTO-GD-0210 

Contents 

Contents i 

Tables iv 

Figures *v 

1. Introduction 1 

2. Inverse Synthetic Aperture Radar (ISAR) 2 
2.1 Basic ISAR Theory 2 
2.2 Radial Motion Compensation 4 

3. The ISARLAB Model 5 
3.1 Modelling Radar and Target Motion 6 
3.1.1 Gross Motion 7 
3.1.2 Induced Motion 9 
3.1.3 Target Alignment 11 
3.2 Modelling Radar backscatter 11 
3.2.1 The Target Scatterer Model 12 
3.3 Modelling the Radar Signal Waveform 13 

4. Getting Data and Information 14 
4.1 Simulating Radar Returns 15 
4.2 Reading a Raw File of Radar Returns 16 
4.3 Saving and Loading Information 16 

5. Radar Signal Processing 17 

6. Display Processing 19 

7. System Description 20 

8. Introduction to Using ISARLAB 22 
8.1 Installing ISARLAB 22 
8.2 Using ISARLAB 23 
8.2.1 Starting ISARLAB 23 
8.2.2 The Graphical User Interface 23 
8.2.3 User Input 23 
8.2.4 Stored Information and Filenames 24 
8.2.5 Prompts and Messages 24 



DSTO-GD-0210 

8.2.6 Exiting ISARLAB 25 

9. Navigating ISARLAB 25 
9.1 The Display Panel 25 
9.1.1 Purpose 25 
9.1.2 File menu 25 
9.1.3 Window Menu 27 
9.1.4 Display Menu 28 
9.1.5 Features Menu 30 
9.1.6 Overlay Menu 30 
9.1.7 Help Menu 30 
9.2 The Button Bar 30 
9.2.1 Purpose 30 
9.2.2 Using this window 31 

10. Using Trial Data 32 
10.1 Data Input Using the Load Menu 32 
10.1.1 Purpose 32 
10.1.2 Using this window 33 
10.2 Data Input Using the Import Menu 34 
10.2.1 Purpose 34 
10.2.2 Using this window 34 

11. Simulation 36 
11.1 Data Input Using the Load Menu 36 
11.2 Specifying Dynamics: Scenario Setup 36 
11.2.1 Purpose 36 
11.2.2 Using this window 37 

12. Signal Processing 41 
12.1 Choosing the Radar: Signal Setup 41 
12.1.1 Purpose 41 
12.1.2 Using this window 41 
12.2 Changing How if s Done: Processing Options 43 
12.2.1 Purpose 43 
12.2.2 Using this window 45 

13. Classifying Ship Targets 46 
13.1      The Classification Aid 46 
13.1.1 Purpose 46 
13.1.2 Using this window 46 

14. The Display Panel 48 
14.1      Miscellaneous Functions 49 



DSTO-GD-0210 

14.1.1 Zooming 49 
14.1.2 Printing 50 

15. A Quick Tutorial 50 

16. References 51 

Appendix A: 3-D Linear and Circular Motion 53 

Appendix B: Raw Data File Formats 54 

Appendix C: Units . 55 

Appendix D: Troubleshooting 56 

in 



DSTO-GD-0210 

Tables 

Table 1: Information that can be saved and loaded 17 
Table 2: Available colour maps 29 
Table 3: Tape recorder button functions 30 
Table 4: Units used internally and in the graphical user interface 55 

Figures 

Figure 1: Illustration of radar and target motion within the global coordinate system. .7 
Figure 2: Definition of induced motions within the local coordinate system 10 
Figure 3: Definition of parameters for reading a portion of data from a file 16 
Figure 4: Radar signal processing steps 18 
Figure 5: Display processing steps 19 
Figure 6: The ISARLAB System 20 
Figure 7: The ISARLAB Setup window 23 
Figure 8: The Display Panel showing the File pull-down menu 26 
Figure 9: The Display Panel showing the Window pull-down menu 27 
Figure 10: The Display Panel showing the Display pull-down menu 28 
Figure 11: The Button Bar 30 
Figure 12: The Movie Options window 31 
Figure 13: The Display Panel showing the File Load pull-down menu 32 
Figure 14: The Load Matlab Data window used for file selection 33 
Figure 15: The Display Panel showing the File Import pull-down menu 34 
Figure 16: The Data Import file selection dialogue window and the Data Import 

window 35 
Figure 17: The Scenario Setup window and the same showing the Induced Motion 

menu 37 
Figure 18: The Position, Linear Motion and Circular Motion windows 38 
Figure 19: The Sinusoidal model Induced Motion window and the SMP File Choice 

window 39 
Figure 20: The Target induced motion graphic 40 
Figure 21: The Signal Setup window 42 
Figure 22: The Processing Options window 43 
Figure 23: The Classification Aid window 47 
Figure 24: The Display Panel 49 
Figure 25: Definition of parameters for circular motion 53 

IV 



DSTO-GD-0210 

1. Introduction 

ISARLAB, which is an abbreviation of "Inverse Synthetic Aperture Radar Laboratory", 
is a suite of programs running under MATLAB® that has been designed to provide 
interactive visualisation of both simulated and experimental Inverse Synthetic 
Aperture Radar (ISAR) data. 

Even though high-resolution radars are becoming more common, there is still a 
fundamental lack of access to real high-resolution radar data. Not everyone has access 
to an experimental radar and those who have are often involved in militarily sensitive 
radar cross section (RCS) research. The problem with collecting data in the field is that 
it costs both time and money. For the study of target classification using high- 
resolution radar, huge amounts of data are needed. 

High-resolution radar simulators are scarce and building a new one from scratch is a 
formidable task. Choosing the modelling complexity of the simulator is a key decision 
that is dependent on the final application. For target detection, simulations based on a 
Swerling model may suffice. On the other hand, for target RCS modelling, it is always 
necessary to collect some real data. Simulators that address RCS calculation or 
prediction are computationally expensive and cumbersome to use, [l]-[3]. Other 
simulators that use simpler scattering models have been geared towards very specific 
problems [4], [5] and therefore lack the flexibility and extensibility required for 
different target types and encounter scenarios. 

The purpose of ISARLAB is to generate high-resolution radar data that can be used for 
target classification studies. ISARLAB is NOT intended for RCS modelling or for 
studying radar backscatter from targets. These types of applications require a 
simulator with a detailed electromagnetic approach because the amplitude of the 
simulated returns must correspond very closely to the amplitude of the real returns. 
ISARLAB attempts to model the information relevant to the task of target 
classification. We made certain key assumptions about the level of simulation 
required for target classification studies and then designed ISARLAB so that these 
important features were modelled. The primary application for ISARLAB is to 
generate simulated data for target classification studies. Nevertheless, ISARLAB can 
also be used to conveniently browse experimental data. 

This document is broken up into two basic parts. The first (Sections 3 to 7 and 
Appendices A to C) equates to a Reference Guide and the second (Sections 8 to 15 and 
Appendices D) equates to a User's Guide, both of which are usually delivered with a 
commercial software package. Prior to these an introduction to Inverse Synthetic 
Aperture Radar (ISAR) and radial motion compensation is given in Section 2. 
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2. Inverse Synthetic Aperture Radar (ISAR) 

2.1 Basic ISAR Theory 

Since the prospective users of this software will have had some exposure to ISAR 
imaging we shall not embark on a detailed description of the theory. Instead we will 
give a brief summary then concentrate on the characteristics particular to our radar 
systems and therefore the data we are able to process. In any case, there are many 
excellent references to this form of radar imaging, most of which can be found in or via 
the texts by Wehner [6] and Mensa [7]. 

The basic principle of ISAR imaging is to coherently collect the wideband echo signals 
that are produced as the object of interest rotates to present a change in viewing angle 
to the radar. Processing the individual wideband echo signals provides information as 
to the relative range of individual scatterers on the target. These range profiles1 can be 
thought of as projections of the target's scattering centres onto the hne-of-sight range 
vector from the radar and if the aspect angle of the target is known, some dimensions 
can be extracted. If the target is assumed to be rotating at a constant rate relative to 
the radar then Doppler spectral analysis of the time-history of range profiles can 
provide additional information about the target's scattering centres. This cross-range 
resolution is achieved because there is a velocity differential across the target caused 
by its rotation that manifests itself in the received signal as a Doppler frequency 
differential. By coherently measuring these signals over time, then performing a 
spectral analysis, the Doppler frequency content and therefore the relative position of 
scatterers can be determined. Since the location of target scatterers to within one range 
resolution cell has already been obtained in generating range profiles, this Doppler or 
cross-range processing makes it possible to separate scatterers that reside in the same 
range cell. The eventual result of these two distinct processing steps is a range versus 
cross-range map of the target's scattering centres, otherwise known as an ISAR image. 

To assist in visualising the form of the ISAR image generated in a given scenario, it is 
useful to note that the projection plane is simply defined as being parallel to the radar 
line-of-sight and perpendicular to the effective rotation axis of the target. The term 
effective is used here because the target does not actually have to rotate but only 
appear to do so from the radar's point of view. An example of this is the situation of 
imaging an aircraft in level flight as it traverses the radar viewing area while being 
tracked by the radar antenna(s). Unfortunately, imaging in this scenario has other 
complications that will be addressed in the section on radial motion compensation 
(Section 2.2). 

The resolution achievable in range, also referred to as slant-range resolution, is directly 
related to the unambiguously sampled bandwidth of the transmitted radar signal, in 
the case of coded waveforms (stepped-frequency, chirp, etc.), or the time delay 

1 Range profiles in this context are also often referred to as high range resolution (HRR) 
profiles. 
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sampling resolution, in the case of uncoded pulses. Specifically, slant-range resolution 
Ars is expressed by the approximate relationship 

Ar,-—, (!) 

where ß is the radar signal's bandwidth and c is the propagation velocity of the 
electromagnetic wave. 

The data that is accepted by this toolbox is assumed to come from radars that use 
either stepped-frequency or linear FM (chirp) waveforms. A stepped-frequency 
waveform consists of transmitting a burst of narrowband pulses, whereby each pulse 
has a carrier frequency which is incremented from pulse to pulse. Processing this 
waveform requires conversion of echo data, collected in the frequency domain (one 
sample per frequency step), into synthetic range profiles. In essence, the frequency 
response of the target collected over some bandwidth is converted into an impulse 
response, with the process typically carried out using an inverse discrete Fourier 
transform (DFT1). 

A linear frequency modulated (LFM) waveform consists of transmitting a relatively 
long frequency coded pulse covering the desired bandwidth. As the name implies an 
LFM pulse has a linear frequency versus delay relationship, or equivalently a 
quadratic phase variation with time. Processing is performed in a pulse compression 
receiver where the return pulse is matched filtered to produce a high-resolution target 
response or range profile. Matched filtering essentially convolves the target return 
pulse with the transmitted pulse to once again give an impulse response. 

The advantage of an LFM waveform is that a high-resolution range profile can be 
obtained with a single pulse compared to the many pulses needed to cover the 
required bandwidth with a stepped-frequency waveform. However, a chirp radar 
requires a larger instantaneous bandwidth than a stepped-frequency radar, and are 
therefore more sophisticated to design and expensive to build. 

The Doppler spectral analysis that results in cross-range target information is applied 
to each range resolution cell in the time-history of range profiles that result from range 
processing (pulse compression). Typically, the process is performed using a discrete 
Fourier transform (DFT). Cross-range resolution Arc will not be derived here but 
simply stated as 

Ar.=-^ = —, (2) 

where X is the radar signal wavelength, © is the effective rotation rate of the target, Tis 
the image integration time and A0 is the effective aspect angle change. It is obvious 
from Equation (2) that in a non-cooperative target imaging situation, where the 
rotation rate of the target is unknown, the cross-range resolution and therefore the 
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cross-range scale on the ISAR image will also be unknown. This feature of ISAR 
imaging is a constant problem when it comes to interpreting a target image and is a 
continuing area of research. 

In summary, the format of data used by ISARLAB is a 2-dimensional array. The first 
dimension is frequency in the form of complex samples (In-phase and Quadrature) of 
the target's frequency response and the second dimension is time. The data is 
organised as a matrix where each row represents one frequency sweep with the pulse 
frequency increasing from left to right (assuming an up-sweep in the case of a 
stepped-frequency waveform or an up-chirp in the case of an LFM waveform). The 
rows are placed in chronological order from top to bottom. The format of intermediate 
data matrices produced during processing is the same orientation as the raw data in 
that frequency samples will be converted to impulse response or range profile samples 
and time will be converted to Doppler frequency or cross-range. In some situations 
the data will have already been range compressed so it will enter ISARLAB in the 
same format as for the intermediate data matrices. 

2.2 Radial Motion Compensation 
The first problem that one encounters when attempting to image real-life radar targets 
is the presence of motions other than the rotational component required by the theory 
and therefore inherently assumed by the signal processing. The most significant 
motion in terms of its effect on image quality is the radial translation component. That 
is, the component of target motion that causes a change in radial distance between the 
radar and target during the image integration time. The major effect of radial motion 
is to shift the position in range of the target return from profile to profile, which results 
in a misalignment of data input to the Doppler spectral analysis. In other words, the 
Doppler frequencies that we are attempting to estimate are spread out over a number 
of range cells. Since the processing acts on range cells independently, there may be 
only a small portion of signal remaining in a particular cell, thereby causing a poor 
estimate of frequency by the frequency analysis. The result of this range walk, where 
scatterer returns effectively "walk" through range cells, is a smearing of the resulting 
image in the cross-range dimension. Naturally, the extent of the smearing is 
dependent on the amount of radial motion. For instance, the image produced by a 
large slow moving ship may suffer minimal distortion that only appears to decrease 
the effective resolution of the system. On the other hand, a jet fighter aircraft will 
almost certainly generate a very distorted image, if a recognisable target image is 
formed at all. 

Range walk can be circumvented if the radar uses a narrow uncoded pulse by 
employing a system that tracks a single prominent scatterer in the target return and 
places that sample into the same resolution cell for each range profile recorded. 
However, for coded waveforms such as stepped-frequency and chirp pulse 
compression, sampling occurs before there is a range profile available for tracking. 
Consequently, the sample position bears no relationship to the position within the 
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resulting synthetic range profile.    Correction for target radial motion is therefore 
required after sampling as part of the signal processing. 

The radial motion compensation algorithm implemented in this toolbox is similar to 
the methods used by Chen and Andrews [8] and Wehner [6], in that it is also a two- 
stage process. The first step sets up a rough alignment of the data from profile to 
profile by removing the phase changes that cause a scatterer at a given cross-range 
position to "walk" out of the range cell in which Doppler processing is being carried 
out. The second step performs fine alignment to account for residual phase changes 
caused by movement in range that exceeds a small fraction of a wavelength. A 
detailed description of the radial motion compensation algorithm will not be 
recounted here since it can be found in Haywood and Evans [9]. As a final remark, the 
type of radial motion compensation used here is sometimes referred to as hot-spot 
tracking, since both stages of the algorithm effectively track one or more prominent, 
although not necessarily the same, target scatterers. 

3. The ISARLAB Model 

ISARLAB can process and display both simulated data or stored data collected from 
experimental trials. When simulating and then processing data ISARLAB is said to be 
in Simulation mode and when processing experimental data it is said to be in 

Trials mode. 

In simulation mode, ISARLAB models a radar illuminating a target with one of a 
number of predefined waveforms or, if preferred, a user defined waveform. ISARLAB 
caters for the two most commonly used wideband radar signals, namely stepped 
frequency and linear FM (chirp). It is relatively easy to incorporate other waveforms, 
by writing code with a simple parameter interface. 

The radar and target can be either stationary, moving linearly or moving in a circle. 
This type of motion, which we call gross motion, is defined relative to a global 
coordinate system in which the radar and target are considered to be moving points. 
This is illustrated in Figure 1 where the radar platform is airborne with a circular 
trajectory and imaging a ship target with a linear motion. The radar and the target 
positions and gross motion are measured in the global coordinate system. The target's 
scatterer positions and its induced motion are measured in the local coordinate 
system. 

The target being illuminated is assumed to be rigid and made of a finite number of 
discrete scatterers undergoing rotations about the origin of a local coordinate system. 
These rotations are called induced motion and are due to the forces applied on ship 
targets by the sea and to a lesser extent on airborne targets by the atmosphere. 

The two coordinate systems are related by the convention that the target's location in 
the global coordinate system is the origin of the local system. They are also related in 
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that the velocity vector of the target in the global system coincides with the x-axis of 
the local system. Both coordinate systems are right-handed. 

The simulated backscatter of the target from the radar in this scenario is then 
processed by selecting from a number of available signal processing algorithms. A 
variety of display formats and options are also available. 

The use of the terms "radar" and "target" were adopted to keep the system general, in 
the following sense. The platform could be an aircraft, ship, or based on land, or even 
transported in an automobile. Similarly, the target can be anything that can be 
represented by a number of scatterers. This includes aircraft, ships, land-based 
vehicles or even man made structures such as buildings. The illustrations in this 
document which portray airborne imaging of ship targets are not intended to imply 
any limitations in this sense. 

ISARLAB, in trials mode, reads previously stored radar returns from experimental 
trials in any of several supported formats, then processes and displays this data using 
the same code used to process the simulated backscatter. 

The system is written in the MATLAB language and runs under version 5.0 or later. 
MATLAB is supported on a number of computer platforms, which makes ISARLAB 
portable by default. ISARLAB is driven by a graphical user interface that is used to 
define new, or read in pre-defined information. This information includes radar 
waveforms, target reflectivity models, radar motions and target motions. The 
processing and displaying selections are also made using the interface. For more 
information on use of the graphical interface see Sections 8 to 15. 

3.1 Modelling Radar and Target Motion 

Motion has been modelled on two scales. An independent coordinate system is 
associated with each scale. Gross motion views the radar platform and target as 
points moving in 3-D space with positions relative to the global coordinate system. 
On a finer scale, the target also has an optional induced motion, which is a pseudo- 
periodic motion due to the forces applied by the sea on boats and ships and, to a lesser 
extent, forces applied by the air on aircraft. Induced motion modifies the positions of 
the individual scatterers with respect to the local coordinate system. The two 
coordinate systems are related as described in Figure 1. Induced motion is illustrated 
in Figure 2. As a final step, target alignment, described in Section 3.1.3, is performed 
after gross and induced motion calculations. The motion updates of the radar 
platform and target are implemented sequentially in the following predefined order: 

1. Update gross motion of radar 

2. Update gross motion of target 

3. Update induced motion of target 

4. Align target orientation 
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3.1.1 Gross Motion 

In general, both the radar platform and the target of interest can have quite arbitrary 
trajectories. To simplify motion modelling, we limit radar and target motion to simple 
trajectories. These trajectories are parameterised by 3-D vectors consisting of: 

1. an instantaneous position, velocity and (constant) acceleration, or 

2. an instantaneous position, a centre of rotation and a rotation axis vector 
(direction and rotation rate). 

Z 
A 

Radar Platform 

Global Coordinates 

Target 

Local Coordinates 

Figure 1: Illustration of radar and target motion within the global coordinate system. 

The first trajectory is called linear motion and the second circular motion. Collectively 
we refer to these trajectories as gross motion. Both the radar's and target's gross 
motion are represented by a single point moving with respect to the global coordinate 
system. 

As well as linear and circular motion, a special case of linear motion has been added 
for convenience. It is called stationary "motion", which as the name implies is a 
specification of a position only (with velocity and acceleration being set to zero). 

The equations of motion which define how each new position can be calculated from 
the old position and the motion vectors are described in Appendix A: 3-D Linear and 
Circular Motion. 
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Rather than specifying 3-D vectors, it is easier to visualise, easier to describe and more 
common to encounter situations that can be described using the following quantities 
(the names below correspond to those seen in the ISARLAB software): 

1. For linear motion: 

• X position (m) 

• Y position (m) 

• altitude (m) 

• heading (degrees) 

• velocity (ms-1) 

• acceleration (ms-2) 

• climb rate (ms-1) 

X position, Y position and altitude; together constitute the 3-D position in the global 
coordinate system. Heading is measured parallel to the X-Y plane. Zero (0) degrees is 
defined to be the same direction as the X-axis and heading increases positively in a 
clockwise direction looking along the Z-axis towards the origin. Velocity and 
acceleration are scalar quantities and both apply in the direction specified by heading. 
The climb rate is the velocity in the Z-axis direction. Velocity and acceleration are with 
respect to the ground and not the air or sea. 

2. For circular motion: 

• X position (m) 

• Y position (m) 

• X position of centre (m) 

• Y position of centre (m) 

• altitude (m) 

• speed (ms-1) 

X position and Y position define the position on the circumference of a circle centred at 
X position of centre and Y position of centre. The circle is parallel to the X-Y plane and 
hence the altitude applies to both the position and position centre. The motion about 
this circle is anticlockwise if speed is positive and clockwise if speed is negative. 
Speed is the magnitude of the instantaneous tangential velocity and is proportional to 
the rate of rotation. Speed is with respect to the ground and not the air or sea. 

In our implementation of gross motion, we translate either the linear or circular 
quantities into an augmented array of three 3-D vectors that are interpreted differently 
according to the context of linear or circular motion. These arrays (shown below) are 
our representation of the radar's or target's gross motion. 

The format for linear motion is: 
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Linear = V. (3) 

where: 

Px, Py, Pz - are the position coordinates of the radar or target (m) 
Vx, Vy, Vz - is the velocity vector of the radar or target (ms-1) 
Ax, Ay, Az - is the acceleration vector of the radar or target (ms-2) 

For circular motion, the format is: 

Circular = 
P*      Py 

(4) 

where: 

Px, Py, Pz - are the position coordinates of the radar or target (m) 
Cx, Cy, Cz - are the position coordinates of the centre of rotation (m) 
Nx, Ny, Nz - is the axis of rotation (radians s1) 

The magnitude of the axis of rotation equals the rotation rate and its direction specifies 
the direction of the rotation based on the "right hand rule". 

For a stationary radar or target the format of the gross motion array is: 

Stationary 
px Py p. 
0 0 0 
0 0 0 

(5) 

where: 

Px, Py, Pz - are the position coordinates of the radar or target (m) 

3.1.2 Induced Motion 

In addition to gross motion, the target may have a motion induced by the medium 
through which it moves. This is most pronounced in seagoing vessels but is also seen 
to a lesser extent in aircraft. In general, 6 degrees of freedom can be used to describe 
an object's induced motion, and these can be separated into 3 linear components 
(surge, heave and sway) and 3 rotational components (roll, pitch and yaw). Since only 
the rotational components have a significant effect on the formation of ISAR images, 
the linear components are not simulated. 
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Induced motion is therefore implemented as rotations applied to the scatterer 
positions, which are defined in the local coordinate system xyz. These rotations 
simulate actual roll, pitch and yaw. They are defined by anticlockwise rotations about 
the x, y and z-axes respectively, where the sense is determined by looking along the 
axes towards the origin. Figure 2 graphically depicts this covention. As rotations only 
commute (approximately) with small angles, the induced rotation is achieved by 
updating scatterer positions over small time intervals. The new positions are stored so 
they can be updated (again incrementally) at the next iteration. The positions together 
with the Motion matrix (Eqn 6) are a representation of the target's current state of 
induced motion. 

Local Coordinates 

»****: 

PITCH 

\J ROLL 

Figure 2: Definition of induced motions within the local coordinate system. 

Induced motion can be specified in two ways. It can be specified crudely by giving the 
amplitude, period and phase of independent sinusoids that represent roll, pitch and 
yaw (as shown below) or more realistically it can be specified using pre-calculated and 
stored sets of roll, pitch and yaw angles that can be read from a file. An example of 
pre-calculated values is the result from a detailed ship motion modelling program [4]. 

If the former method is used, the array of parameters describing the induced target 
motion is: 

Motion A„ 

T_    P. 

(6) 

10 
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where: 

Ar, Tr, Pr - is the amplitude, period and initial phase for the roll angles 
Ap, Tp, PP - is the amplitude, period and initial phase for the pitch angles 
Ay, Ty, Py - is the amplitude, period and initial phase for the yaw angles 

Roll is defined to be rotation about the x-axis, pitch is rotation about the y-axis and 
yaw is rotation about the z-axis. Amplitudes and phases are entered as degrees but 
stored as radians and periods are in seconds. 

3.1.3 Target Alignment 

Target alignment refers to the alignment of the local coordinate system with the target 
velocity vector, as measured in the global system. If this is not done, unrealistic 
situations such as the target moving "sideways" may arise. The convention we follow 
is that the local x-axis represents the "forward" direction for the target, hence we align 
the local x-axis with the target's velocity vector. A copy of the scatterer positions is 
maintained and target alignment is applied to this copy. 

3.2 Modelling Radar backscatter 

Radar backscattering from targets can be categorised into 4 main mechanisms: 

1. Direct illumination specular scattering normal to surfaces or edges. 

2. Diffractive scattering from edges and surface discontinuities. 

3. Travelling wave scattering along edges. 

4. Indirect (multiple) specular scattering from structures or cavities. 

Normally the specular and diffractive mechanisms account for the majority of the 
radar backscatter. Specular backscatter is normally much larger than its diffractive 
counterpart. Travelling waves are important at long wavelengths. For the X-band 
frequencies (8-10 GHz) considered here, travelling wave backscatter is therefore not 
important. Backscatter due to multiple specular reflections is common for complex 
faceted structures such as ships, but less frequent for the smooth surfaces typical of 
aircraft. Multiple specular scattering from cavities occurs infrequently. It is also 
difficult to determine when this sort of backscatter is occurring. 

The assumptions on which we base our target scattering model are as follows: 

1. The target is rigid bodied with no rotating parts or engine cavities. 

2. Since we are modelling in the high frequency (Fresnel) region, the target is 
represented as a finite number of discrete scatterers in 3-D space. 

3. We assume the scatterer positions are more important for classification than 
their respective amplitudes. This does not mean that we fail to model relative 
amplitude differences between scatterers but that the exact level of the 
backscatter amplitude is not critical to our modelling. 

11 
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4. Target classification will be made on the basis of major target scatterers hence 
modelling minor target features is lower priority. 

We supplement these assumptions with the following conventions: 

1. The positions of the target scatterers are defined with respect to a local 
coordinate system xyz. The origin of this local system is referred to as the 
position of the target or the target's origin in the global coordinate system XYZ. 
Ideally the target origin should correspond to the effective center of rotation of 
the target with respect to the radar. If this is not the case, then the Doppler 
returns from the target will be shifted. (This is not a critical issue because in 
real target imaging the apparent centre of rotation will normally shift during 
the course of relative motion). 

2. The scatterer positions should be defined so that the target is "forward" along 
the x-axis and that the target is "level" in the x-y plane. This information is 
used in realigning the orientation of the target as its velocity changes direction 
and to define the state of equilibrium about which the induced motion applies. 
See Section 3.1 for more information about target alignment. 

3.2.1 The Target Scatterer Model 

The above assumptions were implemented by modelling the target scatterers as a set 
of points such that for each scatterer we have defined: 

• x-coordinate position (m); 

• y-coordinate position (m); 

• z-oordinate position (m); and 

• reflectivity or radar cross-section (dBsm). 

Since target scattering is heavily dependent on the aspect angle at which the radar 
illuminates the target, it was necessary to allow a separate point scatterers' model for 
each angle in a range of aspect angles. Consequently, the whole model is composed of 
a 2-D array of points with one dimension being the set of points (position and 
reflectivity) defining the target scattering at a particular aspect angle and the other 
dimension being all the valid aspect angles for which there are corresponding models. 
Aspect angle is actually composed of two components, azimuth and elevation, but to 
simplify the modelling we consider aspect angle to be synonymous with azimuth 
angle. It is therefore assumed that one would need a different target model for each 
elevation angle to be simulated. Since scattering does not change significantly with 
the small changes in elevation, one model will usually suffice for a broad range of 
scenarios. 

Aspect angle (azimuth) is by convention measured from the target to the radar in the 
X-Y plane of the global coordinates and in a clockwise sense from the forward 
direction of the target. For example, an aspect of 90° means the target is illuminated 
on its starboard  broadside.     Therefore,  to incorporate all possible radar-target 
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geometries, the target model must cover a full 360° of aspect angles. However, this 
can be broken up into angular increments as fine as is deemed necessary to model real 
scattering variations. 

ISARLAB uses the scatterer model by determining the aspect angle being simulated in 
a given scenario and selecting the list of point scatterers at the nearest corresponding 
aspect. Gross motions and induced motions are then imparted on the target scatterers 
before the received signal is generated. This is done by effectively convolving the 
impulse response for each scatterer with the transmitted signal then summing 
coherently. This procedure is further described in Section 4.1. Therefore, as the 
scenario changes, so does the set of point scatterers selected to represent the target. 

3.3 Modelling the Radar Signal Waveform 
The two most common high bandwidth waveforms used in high-resolution radars are 
stepped frequency and linear frequency modulation (chirp). ISARLAB accommodates 
both of these waveforms as well as a "pseudo" waveform called compressed linear 
frequency modulation. This is a special case of chirp where the pulse compression has 
already been performed. An example of this for a real radar occurs where pulse 
compression is done passively in a SAW compressor before A/D sampling. The 
parameters required for each waveform are listed below. Note that in the case of the 
stepped frequency waveform, the bandwidth is termed effective because it is 
synthesised from a number of discrete frequencies. The term burst refers to the 
transmission of a series of discrete frequency pulses. The sampling frequency is the 
rate at which pulses in this burst are transmitted (i.e. the real PRF). For more 
background on radar waveforms see Wehner [6]. 

The calculations that simulate the generation of the raw radar signals proceed on a 
single range profile basis. This means there is no relative motion during the collection 
of the data required in forming a range profile. A chirp radar only requires a single 
pulse to form a range profile, so the target and radar positions are updated after every 
pulse. A stepped frequency radar requires a burst of pulses to form a range profile, 
therefore the target and radar positions are updated after each burst. The onus is on 
the user to ensure relative motion during the stepped frequency burst time is not 
significant in the imaging scenario being simulated. In real-life imaging scenarios this 
calculation must also be done to ensure that minimal distortion is achieved. 

Parameters for a stepped frequency waveform are: 

• Centre frequency (Hz); 

• Effective bandwidth (Hz); 

• Pulse width (seconds); 

• Effective pulse repetition frequency (Hz); 

• Sampling frequency (Hz); 

13 
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• Number of frequency samples per burst; 

• Number of bursts per ISAR image; and 

• Signal to noise ratio (dB). 

Parameters for a chirp waveform are: 

• Centre frequency (Hz); 

• Chirp bandwidth (Hz); 

• Pulse duration (seconds); 

• Pulse repetition frequency (Hz); 

• A/D sampling frequency (Hz); 

• Number of A/D samples per pulse; 

• Number of pulses per ISAR image; and 

• Signal to noise ratio (dB). 

Note that in Trial mode the signal to noise ratio is undefined and therefore not used. 

Our implementation employs an enumerated data type called Radar Waveform that 
gives the context in which to interpret the Signal Waveform array for different 
waveforms. The parameters in this array are listed below and are interpreted as the 
corresponding parameters above. 

Radar Waveform type; 

Centre frequency (stored as Hz, entered as GHz); 

Frequency bandwidth (stored as Hz, entered as MHz); 

Pulse width or duration (stored as seconds, entered as microseconds); 

Pulse or burst repetition frequency (Hz); 

Sampling frequency (stored as Hz, entered as kHz); 

Number of samples per pulse/burst; 

Number of pulses/bursts per image; and 

Signal to noise ratio (dB). 

4. Getting Data and Information 

Now that the model has been described and some terminology has been introduced, 
we can describe in more detail the three main parts of the ISARLAB system. 

The first part, used in simulations, is to define an instance of the model (see below) 
and to use this to generate radar returns.   Alternatively, in trial mode data is not 
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generated, but is instead read from files of stored radar returns. The first part is 
described in this section. The other two parts, processing the radar returns into an 
image and displaying the image are described in Section 5 "Radar Signal Processing" 
and Section 6 "Display Processing", respectively. 

The facilities available in ISARLAB for saving and loading information are described 
in this section. 

4.1 Simulating Radar Returns 
For simulation, the graphical user interface is used to define the: 

• gross radar motion; 

• gross target motion; 

• induced target motion; 

• target scatterers; and 

• radar signal waveform, 

which together comprise an instance of the ISARLAB model. 

All of these components have been described earlier in some detail. Of these only the 
induced target motion is optional. If not defined, the system defaults to "no induced 
motion". Using this information the radar returns for the given model can be 
generated as follows. 

The simulation defines the transmitted signal at frequency /and time fas 

exp(j2nft) (7) 

and the received signal from a number of scatterers as 

ZAkexp(j2xf(t-Tk)) (8) 

where xk is the two-way time delay to the A* scatterer, with k ranging from 1 to the 
total number of scatterers, and Ak is the reflectivity of each scatterer. 

When demodulated we have 

ZAkexp(j27rfTk) (9) 
k 

which yields the amplitude and phase change from transmitted to received signals. 

The next stage is the signal processing of these simulated radar returns (Section 5). 
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4.2 Reading a Raw File of Radar Returns 

We can also use the graphical user interface when processing data from experimental 
trials. It is used to specify the name and format of the file containing the stored radar 
returns and to specify the location and quantity of data to be read. Figure 3 shows 
how to specify which rectangular block of stored radar returns to read. In this 
illustration the file is made up of stepped frequency data, but the same principle 
applies to data that has already been range compressed. Uncompressed chirp data 
however, would require all the samples for a pulse to be read for successful range 
compression. Reading localised data segments is necessary as memory limitations of 
computer hardware means that the system can often not accommodate the massive 
amounts of data that are typically collected on trials. This segment of data is 
converted from binary format to complex numbers and then read into memory for use 
by ISARLAB. Also, if a file header is available, the information it contains can be used 
to automatically specify the signal waveform. 

File of Radar Returns 

Number of sweeps to skip 

Number of sweeps to read 

Number of steps to skip 

Number of steps to read 

Figure 3: Definition of parameters for reading a portion of data from a file. 

4.3 Saving and Loading Information 

Information entered or selected by the user, such as gross motion of radar and target, 
induced motion of target, signal parameters, and signal and display processing 
options, can be saved, then loaded at a later time. The user then becomes more 
efficient because they, 
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1. save time by not repeatedly entering the specifications that created them; 

2. save time by not needing to wait for them to be recreated; 

3. do not need to remember them or note them somewhere outside the system; 
and 

4. can give meaningful names to the information saved and form logical sets of 
information that can be stored with the data (e.g. in the same directory). 

Table 1 summarises the information that can be saved and loaded. 

Table 1: Information that can be sa ved and loaded. 

Mode Information Variables Involved Comments 
Simulation Data ßledata, tx Save Only (fr-only saved for 

linear FM waveform) 
Signal signal 
Scatterer Model scats Load Only 
Scenario radar, target, motion 
Movie M Can be a large file 
User Selections userseln An array that holds all 

display and processing 
selection 

Trial Data ßledata, tx fcronly loaded for linear FM 
Signal signal 
Movie M As for Simulation 
User Selections userseln As for Simulation 

Note that in Simulation mode with a linear FM wavform a replica of the transmitted 
signal txis generated for the matched filter range compression process. This variable 
is always saved automatically with the data so that the two remain associated when 
the simulated data is loaded in Trial mode for re-processing and display. 

5. Radar Signal Processing 

ISARLAB can perform various types of radar signal processing. The processing is 
broken into modular sections so that new processing algorithms can be easily 
incorporated (these are summarised in Figure 4). The signal processing discussed 
here is performed after the generation of the signals returned from the target models, 
and results in the production of 1-D range profiles or 2-D ISAR images. Division of 
the signal processing in this way allows ISARLAB to process experimentally collected 
radar data as well as simulated data. 
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Raw Radar Returns 
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Figure 4: Radar signal processing steps. 

The processing of the return signal is achieved in three steps. The first step, called 
range processing or range compression, essentially deconvolves the return signal 
using knowledge of the transmitted signal. This provides the impulse response of the 
target (range profile). The second step is radial motion compensation that attempts to 
remove the relative radial movement between the radar and target. A number of 
phase compensation algorithms are supported by ISARLAB [9]-[ll]. The third and 
final step in the ISAR image production is Doppler processing. Here a spectral 
analysis is performed in each range resolution cell to estimate the distribution of 
Doppler frequencies and hence the cross-range positions of target scatterers. Various 
signal processing windows can be applied before both the range and Doppler 
processing stages [12]. 
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6. Display Processing 

Display processing is performed in four steps. These are illustrated in Figure 5. 

First, the data output from the signal processing stage is converted to decibels (dB). 
This change from a linear scale to a logarithmic scale makes a large dynamic range 
easier to visualise. This results in more detail being apparent in the final image. 

Convert Extract Linearly Use integers to 

Processing intensities user-defined scale into index into current 

to dB dynamic 
range 

integers colormap to get 
RGB values 

maximum dB 

data from 
signal — 

processing 

data to 
display 

y 
Image of large 
dynamic range. 
Intensity is a 
linear scale. 

/ 
Image of large 
dynamic range. 
Intensity is a 
logarithmic scale. 

Image of limited 
dynamic range. 
Intensity is still 
logarithmic. 

Image of limited 
dynamic range. 
Intensity is now 
integers 0 to 255. 

RGB 
values 

Figure 5: Display processing steps. 

Next, a subset of the dynamic range is selected from the data for closer inspection. 
This is necessary because the dynamic range of the display device is much less than 
that of the radar data. Values outside of this range are clipped. If the range starts 
from the maximum intensity image pixel, which is arbitrarily set to zero, then this is 
called autoscaling. Autoscaling is the default supported by ISARLAB. Alternatively, 
a maximum intensity (in dB) can be specified and clipping occurs above this 
maximum and under the dynamic range below this maximum. 

The next step is to linearly map these intensities (which are real numbers) into the 
range of integers that index the current colormap. The current colormap is the set of 
Red, Green and Blue (RGB) values that are stored in an array into which the integers 
will index. There are a number of colormaps that are available. More information on 
colormaps is available in Section 9.1.4.2. 
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Finally these numbers are the values that MATLAB uses to display the ISAR image. 
There are currently two representations of the ISAR image, namely a MATLAB 
surface plot and a MATLAB image plot. Both are intensity maps but have different 
properties that are described in Section 9.1.4.1. In later versions it is anticipated that a 
number of other representations of the final image could be available, e.g. waterfall 
plots, contour plots, etc. 

7. System Description 

Each of the previous sections described a particular component of ISARLAB. It is now 
appropriate to show how these components are combined to form an integrated 
system. A data flow diagram describing the ISARLAB system at the module level is 
shown in Figure 6. This graphic also shows how processing in the ISARLAB system 
can be separated into three stages: 

1. Generating Simulated Data or Reading Stored Data; 

2. Signal Processing; and 

3. Displaying the Processed Data. 

Radar 
Signal 

Generating 
or Reading 

Data 

Signal 
Processing 

Displaying 
Processed < 

Data 

Scatterer 
Model Scenario 

->|    Simulation    W- 

Trial 
Data 

Read File 

Rx & Tx Data 

Radar Signal 
Processing 

Image 

Display 
Processing 

RGB Values 

Figure 6: The ISARLAB System. 
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To further assist in understanding how all the components fit together, a high-level 
pseudo code summary of the ISARLAB system is presented below. 

{initialisation} 
if SIMULATION 

define radar,target,inducedjmotion,scatsmodel,signal 
else 

define signal 
filedata = readfile(filename,fileformat) 

end 
{end initialisation} 

{main program} 
if SIMULATION 

while PLAYING 
[rx, tx, radar, target, scats, induced_motion] = ... 

radsim(signal,radar,target,scatsmodel,scats,induced_motion) 

image = isar_process(rx,tx,signal) 
show_imag(image,signal,output_format) 

end 
else 

while PLAYING and not END_OF_DATA 
[rx,tx,image_no] = get_next_block(filedata,image_no) 
image = isar_process(rx,tx,signal) 
show_image (image, s ignal, output_f ormat) 
image_no = image_no + 1; 

end 
end 
if RECORDING 

movie = append(picture,movie,frame) 
end 
{end main program} 

{radsim} 
for It = 1 to number_of_pulses 

if sf_waveform 
[rx,tx] = simulate_sfdata(time_inc,signal,radar,target,scats_posns) 

elseif lfm_waveform 
[rx,tx] = simulate_lfmdata(time_inc,signal,radar,target,scats_posns) 

end 
radar = update_global_motion(radar) 
target = update_global_motion(target) 
[scats,induced_motion] = update_induced_motion(scats,induced_motion) 
scats_posns = update_orientation(scats,target_velocity) 

end 
scats = calc_reflectivity(scatsmodel,scats,radarjoosn,target_posn) 
{end radsim} 

{simulate_sfdata} 
dt = burst_repetition_interval {from signal information} 
delays = calculate_delays(dt,scats jiosn,target_posn,radar_posn) 
generate transmitted sf signal 
generate received sf signal 
{end simulate_sfdata} 
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{simulate_lfmdata} 
dt = pulse_repetition_interval {from signal information} 
delays = calculate_delays(dt,scats_posn,target_posn,radar_posn) 
generate transmitted lfm signal 
generate received lfm signal 
{end simulate_lfmdata} 

8. Introduction to Using ISARLAB 

8.1 Installing ISARLAB 

ISARLAB is a computer program consisting of a set of functions (called M-files) that 
are written in the MATLAB language. Such a set of M-files is often called a toolbox. 
Instructions for installing ISARLAB and for installing toolboxes in general can be 
found in the Installing Additional Toolboxes section of the MATLAB Installation 
Guide for UNIX[13], or Installation Guide for PC and Macintosh [14]. 

ISARLAB has been designed to work in conjunction with the BAR toolbox, which 
contains the necessary radar signal processing algorithms. More information about 
this set of functions can be found in the ISAR Image Processing Toolbox User's Guide 
[15]. To function, the ISAR toolbox in turn needs MATLAB's Signal Processing 
Toolbox[16]. 

It is recommended that the ISAR and ISARLAB toolboxes be placed in separate 
directories under $MATLAB/toolbox/. However, regardless of where the toolboxes 
are kept, paths to the location of these and other files required by ISARLAB can be 
defined using a setup utility. This function (type setupil at the MATLAB 
command line prompt) should be run prior to running ISARLAB for the first time. 
The ISARLAB Setup window will then appear (Figure 7), from which a range of 
options and parameters can be set by pressing the appropriate button and editing the 
choices in the corresponding window that appears. In each case the Save ... button 
needs to be pressed to save the corresponding set of chosen options, parameters, etc. 
Finally, the user should set up a MATLAB path pointing to the ISARLAB toolbox so 
that the application can be run from any current directory. 

ISARLAB has been designed to run on any of the many platforms that MATLAB 
supports. It has been tested on UNIX systems (SUN SPARCstations and DECstations) 
and IBM compatible PCs. To work on other platforms minor modifications may need 
to be made. For example, window sizes may need to be adjusted to suit the often- 
smaller screen displays associated with some PCs or minor code changes may be 
needed to accommodate minor MATLAB language aberrations between platforms. 
The graphical user interface widgets or controls (Section 8.2.2) may also appear and 
work slightly differently between platforms. 
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Figure 7: The ISARLAB Setup window. 

8.2 Using IS ARLAB 

8.2.1 Starting ISARLAB 

Starting ISARLAB involves just two basic steps. The first step is dependent on the 
computer platform you are using and should be done after consulting your MATLAB 
documentation if you are unfamiliar with MATLAB. The second step runs ISARLAB. 

1. At the command line prompt start up MATLAB. 

2. Within MATLAB type: isarlab 

3. If desired, change to a working directory that has or will have data and 
information files (Section 8.2.4 explains this further). 

8.2.2 The Graphical User Interface 

ISARLAB has a Graphical User Interface (GUI) for ease of use. This means that the 
mouse is used extensively to manipulate regions on the screen called controls. 
Examples of controls are popup menus, push buttons, radio buttons and editable text. 
The MATLAB manual called Building GUIs with MATLAB [17] describes the 
appearance and use of these and other controls, as well as how to create them and 
designing them into a layout. 

8.2.3 User Input 

Note that most input is driven by the mouse but occasionally it is necessary (and is 
easier) to type in a number or name. Names are only used for files (see Section 8.2.4). 
Numbers can be any valid numeric MATLAB expression. Examples of valid numeric 
expressions are: 
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• 20 

• 5.12e7 

• exp(i  * pi) 

• round(128  *  rand -   64) 

Names or numeric expressions are entered in editable text controls and if numeric data 
is expected and non-numeric data is entered the system "crashes" and a fatal message 
is displayed. If a name is expected and an invalid name is entered, in general an 
informative message is displayed and the user can try again. The context of the 
information to be entered should make it clear whether a number or name is required. 

8.2.4 Stored Information and Filenames 

ISARLAB stores or loads information and reads data from files that are usually 
organised into directories. Files have associated names that vary in format between 
computing platforms. Consult your system administrator or operating system 
manual if unsure what constitutes valid names, or what makes up a file or directory. 
It is recommended that related files all coexist in the same directory, which you can 
change to before reading, saving or loading (see Sections 10.1, 10.2 and 11.1 for full 
descriptions of these functions). 

A filename of raw data or ISARLAB information can be entered in the editable text 
areas of some windows. Include full paths in the name if you are not in the same 
directory as the information. If an asterisk is in any part of the filename, a new 
window appears that allows you to navigate about the file system with the mouse and 
to select a filename. Once the filename is selected, the new window will disappear 
and the selected name will replace the typed name containing the asterisk. 

The term raw data refers to radar returns in binary format. Information, in contrast, is 
output generated by ISARLAB such as stored user selections, an animated movie or 
binary data converted to complex matrices. This information is saved in MATLAB's 
special mat-file format. This use of files means that only valid filenames (for the 
particular computing environment on which ISARLAB is being run) can be used to 
save and load information. The filenames will by default have a '. mat' ending or 
extension but this is entered optionally by the user. 

More information on the contents of the information files can be found in Section 4.3. 

8.2.5 Prompts and Messages 

In keeping with MATLAB standards, messages are displayed in the command 
window (i.e. the window that has the interactive MATLAB prompt). There are three 
types of messages. Informative messages are those that are meant to make the user 
aware of the state of the system, for example the fact that an operation is in progress 
or has completed successfully.    Diagnostic or Warning messages are those that 
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describe the unexpected situation that has occurred, such as data to be expected in a 
file was not found or that selected or entered values are not valid. Fatal messages are 
rare and occur in exceptional circumstances such as entering a non-numeric MATLAB 
expression in a numeric field. Numeric expressions are described in Section 8.2.3. 

In general, all but fatal messages are recoverable. Fatal messages can be recognised by 
the leading'???' characters before the message. ISARLAB will often work even after a 
fatal condition has occurred, but if problems persist then it is recommended to exit 
ISARLAB and start again. Memory limitation problems are the most likely cause for 
needing to restart the program. 

8.2.6 Exiting ISARLAB 

When finishing an ISARLAB session, exit by selecting the Exit item on the File 
menu in the Display  Panel window (Figure 8).   This should clear all ISARLAB 
windows and leave you at the MATLAB prompt. To exit MATLAB itself, simply type 
quit. 

9. Navigating ISARLAB 

9.1 The Display Panel 

9.1.1 Purpose 

ISARLAB was designed to be functionally modular, which means that each 
component is independent of any other, although they can communicate by passing 
parameters, etc. The Display Panel (Figure 8), in addition to being where data (i.e. 
range profiles, images, etc.) are displayed, is in fact the main control panel for 
ISARLAB. Command of ISARLAB and access to all the user-defined components is 
achieved via a number of pull-down menus located along the top of the Display 
Panel. These menus are briefly outlined below and further details can be found in a 
corresponding section of this document. 

9.1.2 File menu 

As the name implies, this menu provides a way of accessing files containing the 
information ISARLAB needs to function. Although most of this information 
(excluding experimental trial data) can be generated internally, the file facility allows it 
to be saved and loaded quickly and efficiently. 

9.1.2.1 Mode menu 

This two-item menu allows switching between the Trial  and simulation modes 
of ISARLAB. Both modes are described throughout this manual. 
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Figure 8: The Display Panel showing the File pull-down menu. 

9.1.2.2 Load menu 

This menu allows user parameters, selections and data to be loaded as required. 

9.1.2.3 Save menu 

This menu allows user parameters, selections and data to be saved as required. 

9.1.2.4 Import menu 

This menu allows raw radar data that has been previously saved in a variety of 
formats to be loaded from file. The import menu only becomes active in trial mode, 
since in simulation mode the radar data is generated by ISARLAB. 
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9.1.2.5 Exit 

Exiting ISARLAB is achieved by selecting this item on the File menu. 

9.1.3 Window Menu 

The window menu provides access to all the user-defined information needed by 
ISARLAB to function. Access in this context means a way of creating new or changing 
existing parameter values. Figure 9 shows the items contained in the Window menu 
for simulation mode. In trial mode the Scenario Setup and Induced Motion 
Plot are not valid and therefore are not selectable. 

:!Dj;spi:av:.Ranel:l^sji^Ml^i'OP^.Ma^ 

Figure 9: The Display Panel showing the Window pull-down menu. 

9.1.3.1 Signal Setup 

The radar's signal is characterised by a set of parameters that can be specified using 
this window. 

9.1.3.2 Scenario Setup 

For simulations, the Scenario Setup window is used to describe the target and 
radar motions. 

9.1.3.3 Induced Motion Plot 

A plot of the induced motion (roll, pitch and yaw) used for simulations can be 
displayed by selecting this item. 

9.1.3.4 Classification Aid 

Once an ISAR image has been generated by processing either simulated or real data, 
the Classification Aid window can be invoked. This tool allows image features 
to be extracted and compared with a database in an attempt to classify the target. The 
classification aid is described in Section 13. 
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9.1.3.5 Button Bar 

Selecting this item simply brings up the Button   Bar shown in Figure 11 and 
described in full in Section 9.1.4.3. 

9.1.3.6 Processing Options 

This window allows a choice of signal processing algorithms to be specified. 

9.1.4 Display Menu 

Choices on how to display the processed data are set using this menu.    Figure 10 
shows the items in the Display menu and with the 4-image display type selected. 

Mimwjniiniiiatotf.iii,i)i«.i»i "»*■■ nini   ■ •■•■ i-HI »i« ii'iinn *«*finit i nit ti-ii ■■_!""- "■*- -t--- f ir i •' 

Figure 10: The Display Panel showing the Display pull-down menu. 
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9.1.4.1 Display Type 

There are three choices of display type. The default display is a single image that is 
updated with every frame displayed. A 4-image display can be selected so that the 
frames are updated in a clockwise order starting from the upper left image. At any 
stage while displaying images in this mode, frames can be frozen by simply clicking 
the mouse button when the cursor is within that quadrant. When one or more frames 
are frozen, new images continue to be displayed cyclically in the remaining quadrants. 
Selecting a frozen quadrant releases it for use. The third choice is a single image, but 
in this case displayed as a surface plot that uses pixel interpolation to give a smooth 
texture. More information about MATLAB's Image and Surface objects can be found 
in the reference guide UsingMATLAB'[18]. 

9.1.4.2 ColorMap and Invert Colors 

A selection of colour maps is available for displaying images and range profiles. The 
colour maps available in ISARLAB consist of most of the standard ones available 
within MATLAB (without prism and flag), plus two others designed specifically for 
displaying radar imagery (green and gsar). A short description of each colour map 
is provided in Table 2. Any colour map is also available in inverted form (highest and 
lowest hues are reversed) by selecting the Invert Colors toggle button. 

Table 2: A vailable colour maps. 

hsv hue-saturation-value 
gray linear gray-scale 
hot black-red-yellow-white 
cool shades of cyan and magenta 
bone gray-scale with a tinge of blue 
copper linear copper-tone 
pink pastel shades of pink 
green a green version of hot: black-green-yellow-white 
jet a variant of hsv 
gsar MIT Lincoln Lab SAR imagery: black-green-yellow-white 

9.1.4.3 Flip LR and Flip UD 

These toggle buttons cause the image to be flipped left-to-right (LR) or up-to-down 
(UD). 

9.1.4.4 Xcc Centering 

Cross-correlation of the current image with a reference image gives an estimate of the 
shift between the two and therefore can be used to centre image frames. Pressing this 
toggle button makes the current image into the reference image and turns this form of 
centering on. A small window pops up to allow manual adjustments of the reference 
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image's position within the display area. This facility is mainly used when wanting to 
produce ISAR movies that exhibit smooth transitions from frame to frame. 

9.1.5 Features Menu 

This menu relates to the manual extraction of features for the Classification Aid 
and only appears when that window is invoked. This menu is described in Section 13. 

9.1.6 Overlay Menu 

This menu relates to the manipulation of 2-D schematic target overlays for the 
Classification Aid and only appears when that window is invoked. This menu is 
described in Section 13. 

9.1.7 Help Menu 

Information about KARLAB and on-line help is obtained using the Help menu. 

9.2 The Button Bar 

9.2.1 Purpose 

The images that ISARLAB produces can be presented continuously or in a "freeze 
frame" manner and the sequence of images can be recorded then replayed. These 
functions are performed using the Button Bar, shown in Figure 11, which has been 
designed with the familiar tape-recorder metaphor and is summarised in Table 3. 

Figure 11: The Button Bar. 

Table 3: Tape recorder button functions. 

Button 
STOP 
PLAY 
STEP 
RECORD 

REPLAY 
RESET 

Function 
Stop play or replay 
Continuous processing and displaying 
Single iteration processing and displaying 
Toggle recording mode 

Replay currently loaded movie 
Several functions (see below)  

Used after hitting 
Any button 
STOP, STEP, PLAY 
STOP, STEP 
STOP, STEP, PLAY, 
REPLAY 
STOP, REPLAY 
STOP 
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9.2.2 Using this window 

To display images continuously, hit the |Piay| button. After a short while, the button 
should light up in green, unless a message is displayed informing you that data needs 
to be read in (trials mode) or the scatterer model needs to be read in (simulation mode) 
or that a signal has not be defined (both modes). 

To stop the images from being presented, hit the |Stop| button. The |Piay| button will 
return to its original color after the next image is processed and displayed. 

To process only one image, display it and then to return to the stopped state, hit the 
|Step| button. This button will go green (or display the same messages mentioned for 
the |Piay| button), display an image, then return to its original color. ISARLAB will 
then wait for your next action. [Step] is equivalent to |Piay| followed immediately by 
|5£öp|. 

(Replay] plays a stored sequence of images. This is commonly referred to as a 
"movie". When [Replay] is pressed one of two things can happen. The first is that a 
message is displayed informing you that no movie has been recorded. In this case 
either create a movie by hitting the [Record] button (if it is not on) and hit [Step] or 
[Play] to begin recording, or alternatively, load a movie from the File menu 
(discussed in Section 10.1). If such a message was not displayed the button will go 
yellow and a new window called Movie Options will appear. This window, shown 
in Figure 12, allows the user to specify, with the aid of slide bars, the frame rate and 
number of loops of the movie to play. Once done, hitting the |Piay| button will bring 
up the Movie Panel, which resembles the Display Panel, and the movie sequence 
will be run. The other buttons on the Movie Options window allow the sequence to 
be stopped before it has completed and closed down. 

If the |Record| button has been turned on (by pressing it and it turning red) while 
producing images with [step] or |Piay|, the next image produced will be appended as a 
frame on the currently stored movie. When all the desired frames have been collected, 
the movie can be replayed and if required, stored using the File menu mentioned 
earlier.  The [Recordj button can be pressed again during continuous play in which 

araraamnii rn-rwi -ttwa;Effiira»«ifl-i.ircJfcirtfg.rni»a. .-..^.^^-J;-»-.^.^.--TJ.-. 

Figure 12: The Movie Options window. 
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case recording will be turned off after the next image is produced. 

The |Reset| button has been added to the Button Bar as a convenience and performs 
several functions as follows (turning white while performing these functions before 
returning to its original color): 

• it turns recording off (which is seen by the [Record] button going from red to its 
original color); 

• resets the image counter, which is used to generate each image's title on the 
Display Panel; 

• blanks the Display Panel; 

• clears the current array of filedata, if selected on the Reset Options window; 

• clears the current movie, if selected on the Reset Options window; and 

• finally, in simulation mode only, it also sets the scenario and scatterer positions 
and induced motion state to those that existed at the start of the simulation. 

10. Using Trial Data 

10.1 Data Input Using the Load Menu 

10.1.1 Purpose 

The Load pull-down menu (Figure 13) allows trial data, radar signal parameters, an 
animated "movie" of images or user preferences to be loaded. A similar Save menu 
allows the same things to be save to file. These facilities are designed to stop the user 
wasting time repetitively entering parameters and also avoid the need to remember 
them. 

Figure 13: The Display Panel showing the File Load pull-down menu. 
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10.1.2 Using this window 

1. Change to a working directory (if the current directory is not the one that holds 
the desired information). This step is unnecessary if you prefer to use full 
paths or browse through directories when inputting the filenames in step 3. 

2. Select the Load (or Save) menu then the item you wish to load (or save), for 
example a file of Matlab Data. 

3. A standard file selection dialogue window (Figure 14) will popup and the 
filename can be typed in the appropriate place or selected from the list. 
Entering filenames is explained in Section 8.2.4. 

4. Once the filename has been found or entered, press the pone| button and the 

file will be loaded (or saved). 

Shortcut keystrokes are available for all of the load and save functions, as well as some 
other functions. These operate by simply typing the key combination (e.g. <ctrl>-M 
for loading Matlab Data) while the cursor is anywhere within the Display Panel. 

agfil «*■»»■>■«* S£.a«.t.s.afrmi6rv.;i*i.iiihrttt 
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Figure 14: The Load Matlab Data window used for file selection. 
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10.2 Data Input Using the Import Menu 

10.2.1 Purpose 

Radar returns, collected on experimental trials and referred to as raw data, are read in 
with the import window (Figure 15). The raw data can be thought of as a number of 
lines made of the same number of samples per line. The data can be in a variety of 
binary formats, but always as I/Q pairs. A sub-block of samples can be read by 
specifying the starting sample, number of samples to read starting from this sample, 
the starting line and the number of lines to read starting from this line (Section 4.2). In 
this way, after experimenting a little with the data, only data of interest can be read 
and processed. Some raw data formats incorporate file or record headers that contain 
auxiliary information about how the data was collected. Signal parameters can be 
automatically set up using this auxiliary information, if available in the particular data 
format being used. 

Figure 15: The Display Panel showing the File Import pull-down menu. 

10.2.2 Using this window 

1. Select the data format from the pull-down menu appropriate to the data file 
about to be read. If this is not known, consult the source from which the data 
was received. Meaningless data may result from using an incorrect data 
format. 

2. A standard file selection dialogue window (left side of Figure 16) will popup 
and the filename can be typed in the appropriate place or selected from the list. 
Entering filenames is explained in Section 8.2.4. 

3. The Data Import window (right side of Figure 16) will then appear. 
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Figure 16: The Data Import file selection dialogue window and the Data Import 
window. 

4. If you want ISARLAB to try to generate the signal parameters automatically, 
turn the Automatic Signal radio button ON. If no signal can be generated, 
an informative message will be generated. 

5. As the file is a continuous sequence of samples with no delimiters between 
lines, ISARLAB needs to know how many samples there are in a line of 
samples. This information is entered in Samples per Line. 

6. The starting line is entered with Lines to Skip. A value of 0 means start at 
the first line. 

7. The starting sample is entered with Samples to Skip. A value of 0 means 
start at the first sample. 
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8. The total number of lines to be read is entered in Number of Lines. 

9. The number of samples per line to be read (starting from the starting sample) is 
entered in Number of Samples. 

The result of these steps is that the I and Q pairs are converted to a complex matrix of 
dimensions 'Number of Lines' by 'Number of Samples'. This data can be saved 
in MATLAB format and loaded later to avoid repeating these steps and to replace the 
reading and conversion process with a more efficient loading of data. 

11. Simulation 

11.1 Data Input Using the Load Menu 
This menu allows the radar signal, the target scatterer model, the scenario, or user 
preferences to be loaded. This menu has exactly the same purpose and works in 
exactly the same way as it did in Trial mode (described in Section 10.1). The only 
differences between the two is the addition of the Scatterer Model and Scenario 
information, which are applicable only for simulations, and the disabling of MaÜab 
Data loading, which has no meaning for simulations. The saving of data and 
information, however, is exactly the same in both Trial and Simulation modes. 

11.2 Specifying Dynamics: Scenario Setup 

11.2.1 Purpose 

The radar's or target's gross motion is specified using the Scenario Setup window 
(Figure 17). A full description of how motion is modelled can be found in Section 3.1. 
The following is a summary. 

The radar or target motion can be described as either stationary, moving in a straight 
line or in a horizontal circle. These are approximations to real manoeuvres (at least in 
short periods of time). Motion is defined relative to a 3-D right-handed coordinate 
system. 

For linear motion the X Position, Y Position and Altitude specify the position 
in space and the Velocity and Acceleration are scalars that are in the direction of 
Heading and parallel to the x-y plane. Heading is measured in degrees where the 
zero reference is the x-axis and increases in a clockwise sense (looking into the z-axis 
towards the origin). Climb rate is defined to be vertical velocity (parallel to the z-axis 
and positive for the same direction). 

With circular motion, the radar or target is on the circumference of a horizontal circle 
(parallel to the x-y plane). Hence the (X,Y) position of the radar or target and the (X,Y) 
position of the centre of the circle define its radius and the altitude of the radar or 
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target is also the altitude of the circle. The rate of rotation is proportional to the 
(instantaneous) speed that is set by the user. A positive speed means the circle is 
traversed in an anticlockwise sense (looking into the z-axis towards the origin). Speed 
and rotation rate are related by 

Rotation Rate = 
Instantaneous Tangential Speed 

Radius 

Induced motion only applies to the target and refers to the roll, pitch and yaw induced 
on the target due to forces by the sea on ships and to a lesser extent by the air on 
aircraft. 

11.2.2 Using this window 

To describe the radar or target dynamics: 

1. Select Scenario Setup from the Window menu on the Display Panel 
window. Wait for the Scenario Setup window to appear (left side of Figure 
17). 

Radar Motion 

Target Motion Target Motion 

Figure 17: The Scenario Setup window and the same showing the Induced Motion 
menu. 

2.   To specify the radar as stationary, in linear motion or circular motion select the 
corresponding option from the Radar Motion popup menu. A new window 
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Figure 18: The Position, Linear Motion and Circular Motion windows. 

will appear that will allow you to enter the specifics of the motion as described 
above. The three window types are shown in Figure 18. 

3. To specify the target as stationary, in linear motion or circular motion select the 
corresponding option from the Target Motion popup menu. A new 
window will appear that will allow you to enter the specifics of the motion as 
described above. These windows are functionally identical to those shown in 
Figure 18. 

4. To specify the induced motion for the target, select one of Sinusoidal 
model, SMP (User defined), SMP (pre-defined), or None from the 
Induced Motion popup menu. If the sinsusoidal model option is chosen, the 
Induced Motion window that appears (left side of Figure 19) will allow you 
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Figure 19: The Sinusoidal model Induced Motion window and the SMP File Choice 
window. 

to enter the amplitudes, periods and a phase offset for the roll, pitch or yaw of 
the target. Note that: 

• A zero amplitude roll, pitch or yaw means that there is no corresponding 
roll, pitch or yaw. 

• A zero period is illegal when the amplitude is non-zero. 
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• If the phase is left blank (this is different from a zero (0) value for phase) 
then a random phase is used. This random value can be seen by hitting the 
|flpplyj button then reinvoking the Induced Motion window. 

If the SMP2 (pre-defined) option is chosen, the SMP File Choice window 
that appears (right side of Figure 19) will allow a file of roll, pitch and yaw 
motion data to be selected from a database. This database is indexed using 
Sea State, Heading relative to swell and Ship Type, but only for 
restricted instances of these parameters. The SMP (User defined) option allows 
a similar file to be selected, but in this case the file could be generated by SMP 
using arbitrary parameters. This option also allows measured ship motion 
data to be used, providing the same MATLAB array format is used. 

5. Pressing the Induced Motion Plot 1551 button will bring up the Target 
induced motion graphic window, an example of which is shown in Figure 
20. This window contains plots of the induced motion used in the simulation 
and shows with a red marker the segment of roll, pitch and yaw motions 
encompassed by the current image frame. The Time field in the bottom right 
corner of the window can be edited to change the time extent displayed in the 
plots. 

Figure 20: The Target induced motion graphic. 

2 SMP is a Ship Motion Program that is run off-line to produce files of roll, pitch and yaw 
angles as a function of time for various parameters [4]. 
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6.   To have the changes acknowledged click the [Apply] button. This updates the 
induced motion parameters and keeps the window visible. Then click |Ciose| 
to quit the window. 

7,   To disregard the changes click the |Ciose| button.   The parameters will not 
change and the window will disappear. 

12. Signal Processing 

12.1 Choosing the Radar: Signal Setup 

12.1.1 Purpose 

This window (Figure 21) is used to define or modify the radar signal waveform 
characteristics to be used. The two most common high bandwidth waveforms used in 
high-resolution radars are stepped frequency and linear frequency modulation (chirp). 
ISARLAB accommodates both of these waveforms as well as being able to accept 
already compressed linear frequency modulated data. The Waveform Type indicates 
how these parameters are interpreted. The parameters required for each waveform 
are listed below: 

Waveform type (Stepped Frequency, Compressed LFM or Uncompressed 
LFM) 

Centre frequency (GHz) 

Frequency bandwidth (MHz) 

Pulse width or duration (us) 

Pulse or burst repetition frequency (Hz) 

Sampling frequency (kHz) 

Number of samples per pulse/burst 

Number of pulses/bursts per image 

Signal to noise ratio (dB) 

Note that in the case of the stepped frequency waveform, the bandwidth is referred to 
as effective because it is synthesised from a number of discrete frequencies. The term 
burst refers to the transmission of a series of discrete frequency pulses. The sampling 
frequency is therefore the rate at which pulses in this burst are transmitted. For more 
information, see Section 3.3. 

12.1.2 Using this window 

To see or modify the parameters: 
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Waveform Type 

Centre Frequency (GHz) 

9.375 

Bandwidth fMHzl 

150 

Pulse Width (us'i 

PRF (Hz) 

Sampling Freq (kHz) 

Samples per pulse 

256 

Pulses per image 

Signal to Noise (dB) 

Figure 21: The Signal Setup window. 

1. Select Signal    Setup from the Window menu on the Display   Panel 
window. Wait for the signal Setup window to appear. 

2. To view the parameters and not make any changes, click the [Closel button 
when finished viewing. This will quit the window without any effect. 

3. Alternatively modify any number of parameters you like. 

4. To disregard the changes click the |Ciose| button.  The signal will not change 
and the window will disappear. 

5. To have the changes acknowledged click the [Apply] button. This updates the 
signal and keeps the window visible. Then click [Closel to quit the window. 
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12.2 Changing How if s Done: Processing Options 

12.2.1 Purpose 
Processing options (Figure 22) allow changes to the signal processing used to produce 
the display output. This includes a choice of using Fourier processing to produce an 
ISAR Image, a single Range Profile or a series of Range Profiles. Range and Doppler 
centering and the number of range and Doppler cells to process and display, are 
selectable. Also, a choice of motion compensation algorithms and signal processing 
windows is also available. Producing an ISAR image with no motion compensation, 
no windowing, use of all available range and Doppler cells and no range or Doppler 
centering is the default. 

•■ ""-" "-TiiT- ^^--'■"^-•■'"»■•■■■*--^-^-'—"-■"■"^'■>' 

Figure 22: The Processing Options window. 
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The signal processing can result in one of the following Result Types or outputs: 

• an ISAR image (produced using Fourier processing) 

• a series of Range Profiles 

• a single Range Profile (coherently averaged) 

• a single Range Profile (non-coherently averaged) 

If windowing is needed, it is available in both range and Doppler directions by using 
the Range Window or Doppler Window popup menus. The windows available are: 

• Bartlett 

• Blackman 

• Hamming 

• Harm 

• Triangular 

Motion compensation involves choosing Range Alignment and/or Phase 
Compensation. There are currently three choices of range alignment Linear, 
Quadratic and Cubic, which refer to the order of curve fitting applied to the 
estimate of range misalignment. Phase compensation, if selected, can be done using 
the Dominant scatterer or Multiple scatterer (using 2, 3 or 4 scatterers) algorithms, 
or PGA (Phase Gradient Algorithm). 

Range centering calculates the location in range of the target's centre of mass and 
rotates the range bins to put that location in the center of the range axis. Range 
centering is also used to keep the target roughly in the same position on the screen for 
making movies. Doppler centering is performed in exactly the same way as range 
centering. However, it is rarely used when phase compensation is employed because 
that process automatically centres the target on zero Doppler frequency. 

The number of range cells to use may be reduced from the maximum available to 
speed up processing or to look at a subset of the image. The number of Doppler cells 
displayed may also be reduced from the maximum available, but this in no way affects 
the processing. 

If the Dynamic Range is specified using only a range in decibels (and the maximum 
left blank), autoscaling occurs. Autoscaling sets the maximum value in the image or 
range profile(s) to OdB and lower values to negative decibels. If the maximum is set, 
autoscaling does not occur and the image is clipped both above the maximum and 
below the dynamic range. 

In Trial mode it is possible to form image frames from contiguous blocks of data or 
from overlapped blocks. The Range  Profile  Skip field allows the user to specify 
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this overlap. The default skip is the same size (in number of profiles) as an image 
frame (i.e. no overlap). This facility is useful when producing animated movies with 
smooth transition from frame to frame. 

12.2.2 Using this window 

To see or modify the options: 

1. Select Processing Options from the Window menu on the Display Panel 
window. Wait for the Processing Options window to appear. 

2. To view the current options and not make any changes, click the |Close| button 
when finished viewing. This will quit the window without any effect. 

3. Alternatively modify any number of parameters you like. Changes to some 
parameters and the radio buttons are immediate and are reflected in changes to 
the Display Panel axes. 

4. To disregard the changes click the |Ciose| button. The signal will not change 

and the window will disappear. 

5. To have the changes acknowledged click the |Appiy| button. This updates the 
processing options and keeps the window visible. Then click |Ciose| to quit the 

window. 

6. Choose the signal processing Result Type you wish from the list. If the 
Display Panel is up then you should expect that selecting a different result 
from the current one will clear the image, the image title and axes. 

7. If the range dimension is to be windowed, select a window other than None 
from those available in the Range Window list. 

8. Choose the Range Alignment algorithm you wish from the list. 

9. Choose the Phase Compensation algorithm you wish from the list. It is 
recommended to use phase compensation when doing range alignment. 

10. If the Doppler dimension is to be windowed, select a window other than None 
from those available in the Doppler Window list. 

11. If Range centering is ON (default is OFF) the radio button will be "depressed". 
Press the Range Centre button to toggle between ON and OFF. 

12. The default number of Range Cells is the maximum number available, as 
defined in the Signal Setup window. If this number is less than the 
maximum then this smaller number of range cells is used evenly about the 
range centre of the display. This has the effect of magnifying the target in the 
display so that if it has a small extent compared to the total range extent it now 
fills more of the display. The danger of decreasing the number of range cells 
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too much is that the target may not be wholly visible within the Display 
Panel window. Decreasing the number of range cells displayed also has the 
effect of decreasing processing time. 

13. If Doppler centering is ON (default is OFF) the radio button will be "depressed". 
Press the Doppler Centre button to toggle between ON and OFF. 

14. The default number of Doppler Cells is the maximum number available, as 
defined in the Signal Setup window. If this number is less than the 
maximum then this smaller number of Doppler cells is used evenly about the 
centre of the display (i.e. zero Doppler frequency). This has the effect of 
magnifying the target in the display so that if it has a small extent compared to 
the total Doppler extent it now fills more of the display. The danger of 
decreasing the number of Doppler cells too much is that the target may not be 
wholly visible within the Display Panel window. 

15. To enter the dynamic range: 

• For autoscaling, clear (if it is not already) the Max field. If autoscaling is not 
required, enter a maximum dB value. 

• Enter a number in dB in the Range field. 

16. Enter the value for Range Profile Skip to be any reasonable integer 
between zero and the total number of profiles in the data set minus the image 
frame size. Negative numbers are allowed and have the effect of moving 
backwards through the data when stepping or playing. 

13. Classifying Ship Targets 

13.1 The Classification Aid 

13.1.1 Purpose 

The classification aid is the only portion of ISARLAB that has been designed with ship 
imaging and ship classification in mind. That is not to say that the tool could not be 
applied to other types of target, but it has been optimised for extracting features along 
a ship's length. This restriction is reflected in the structure of the database that 
contains feature vectors of known target classes. 

13.1.2 Using this window 

To classify a target after generating a real or simulated image: 

1. Select Classification Aid from the Window menu on the Display Panel 
window. Wait for the Classification Aid window to appear (Figure 23). 
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Figure 23: The Classification Aid window. 

2. Enter the aspect angle (in degrees) between the radar and target. In Trial 
mode this should be obtained from auxiliary information recorded with the 
data. Otherwise in simulation mode a value corresponding to the simulated 
scenario will be automatically entered in the Aspect edit-box. An aspect angle 
is mandatory for all of the following operations to function. If unknown, a 
value of zero (0) can be entered and the length and width calculations will then 
give minimal values. 

3. To obtain the length of the target, click the Length |G5| button. ISARLAB will 
prompt you to click on the bow and stern of the target (in that order). The 
aspect angle corrected distance between those two points will be displayed in 
the Length text-box. ISARLAB will then automatically compare this 
"unknown" target length with that for all the known targets in the database 
and return a list of names in the Ship Class popup-menu in decreasing order 
of matching score. Successful operation will obviously depend on an image in 
which the bow and stern are discernable. 

4. Target width is extracted in a similar manner by clicking the width pöl button. 
ISARLAB will prompt you to click on both sides of the target. This should be 
done at the position where the target image appears widest and the two points 
need to be at the equivalent place on either side. When a value is displayed in 
the width text-box, the classification algorithm is re-run to give a new estimate 
of target class that then updates the list of names in the Ship Class popup- 
menu. 

47 



DSTO-GD-0210 

Once an initial classification has been done, the Features menu on the 
Display Panel window will appear. Following visual identification of one 
or more structural features along the ship's length, this pull-down list allows a 
feature type to be chosen, an importance rating to be assigned to it and then its 
position relative to the ship's bow to be extracted with a mouse click. After 
each feature has been identified/extracted, the classification algorithm is re-run 
to give a new estimate of ship class. 

To activate the overlay facility, select a name from the Ship Class popup- 
menu and a 2-D schematic drawing of the ship will be superimposed on top of 
the image. Each overlay has been correctly scaled to represent the target's true 
length in range at the specified aspect angle. Manipulation of the target 
overlay to achieve a better visual match with the image is done using the 
Overlay pull-down menu on the Display Panel window. Three overlay 
manipulation functions are currently implemented: 

• Stretch is used to make the overlay fit the image and is achieved by 
clicking and dragging a bounding box into which the schematic drawing is 
stretched. 

• Translate allows the overlay to be moved to any position within the 
display and is done by dragging a point on the schematic to the desired 
point on the display. 

• Rotate is simply rotation of the overlay about the x, y and z-axes of the 
display. This is performed by entering one or more angle values into the 
Rotate Overlay window that pops up after selecting the rotate function. 

To restart the classification tool you can press the Length or Width [Go] 
buttons, or press the |Close| button then reopen the Classification Aid 
window. 

14. The Display Panel 
The results of all the processing and display options for the data that was either, input 
from a file of sampled radar returns or simulated by ISARLAB, is presented in the 
Display Panel; an example of which is shown in Figure 24. This window appears 
on starting up ISARLAB and comprises two parts. The legend reflects the colors that 
correspond to different intensity levels in the image and is on the right side of the 
window. The axes to the left of the legend bound where the image appears. The title 
over the image reflects the source of the data, the number of the first and last records 
of the data array used in forming the image and the corresponding position in time of 
the first record relative to the beginning of the run. 
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Figure 24: The Display Panel. 

14.1 Miscellaneous Functions 

14.1.1 Zooming 

Although the zooming facility that is provided on the Processing Options 
window by selecting the number of Range and Doppler Cells appears flexible, 
there may be occasions when the best magnified view of the image cannot be obtained. 
In these situations one can resort to MATLAB's zoom function. This function can be 
used in a number of ways, although the easiest is to turn it on by making the Display 
Panel the active window and then simply typing zoom on at the MATLAB prompt. 
Once in this mode the image can be magnified using the mouse, by clicking the left 
mouse button to zoom in on the current location of the pointer or clicking the right 
button to zoom out.   Each time a mouse button is clicked, the axes limits will be 
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changed by a factor of 2 (in or out). You can also click and drag a box with the left 
mouse mutton to zoom into the area defined by that box. 

Care should be taken to turn zooming off (by typing zoom off at the MATLAB 
prompt) when finished, as this function disrupts the operation of the classification aid. 

14.1.2 Printing 

While no printing facility has been built into ISARLAB, MATLAB has an extensive 
range of options for printing figures. Either type help print at the MATLAB 
prompt or consult the reference guide Using MATLAB [18] for printing options. 

15. A Quick Tutorial 

ISARLAB comes with a small set of example files so that a simulation can be run 
immediately. To run the simulation of a simple ship sailing in a straight line in Sea 
State 3 while being imaged by airborne radar, do the following: 

1. Change to the directory containing the example files. 

2. Select Simulation mode from the File menu on the Display Panel 
window. 

3. Select the File Load menu and the signal item, then choose the file 
sf_l. sig using the Load Signal file selection dialogue window. 

4. Repeat this process to load both a scenario (file: Iinl50ss3 . sen) and a target 
scatterer model (file: simple. tgt). 

5. The signal parameters can be seen on the Signal Setup window that appears 
after selecting the Signal Setup item from the Window menu on the Display 
Panel window. 

6. To see the scenario parameters, select Scenario Setup from the window menu 
on the Display Panel window. The Scenario Setup window should 
appear and indicate that the both the radar and the target are in linear motion 
and that there is no induced motion. 

7. Select the current, i.e. linear, option for Radar Motion to see a window 
appear indicating that the radar is initially situated at a range of 50 km behind 
the target, at 300 m altitude and on a heading of 0 degrees at a velocity of 160 
ms-1. 

8. Select the current, i.e. linear, option for Target Motion to see a window 
appear indicating that the target is initially situated at the origin, at sea level and 
also on a heading of 0 degrees, but at a velocity of 9 ms-1. 
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9. Select the SMP (pre-defined) option from the Induced Motion menu and 
from the SMP File Choice window choose sea state 3, heading relative to 
swell of 120 degrees and an FFG ship type, then hit |Accept|. 

10. To see the Target induced motion plot press the |5ö| button on the 

Scenario Setup window 

11. At this point, you can close the windows opened in each step above, leaving 
only those that were initially displayed, i.e. the Processing Options window, 
the Display Panel and Button Bar. 

12. Hit the |5Eep| button on the Button Bar. After a moment it should go green 
and after a short while an image should appear. (Don't be alarmed to see that 
the image is unfocused). 

13. To see the effect of motion compensation (focussing the image), in the 
Processing Options window select linear from the Range Alignment 
popup menu and Multiple (3) from the Phase Compensation popup 
menu and then hit |Apply|. The image will be reprocessed with motion 
compensation and re-displayed. 

14. Next, try changing the Result Type on the Processing Options window, to 
each available option, followed by the |Apply| button. 

15. Finally, see how changing each setting in the Display menu affects the image. 
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Appendix A: 3-D Linear and Circular Motion 

Recall that according to Newtonian dynamics an object with a position p, velocity v 
and constant acceleration a will have a new position after a time f according to 

where the velocity will have a new value after the same time f according to 

v„„ = v + at, 

(A.1) 

(A.2) 

and acceleration is a constant 

ancH,=a = const. (A3) 

This motion is often referred to as "linear motion" although it is general enough to 
describe motion such as the parabolic trajectories that are exhibited by falling objects. 

There also exists an equation to describe the new position for an object that 
circumscribes a circle. The circle's centre is, without loss of generality, assumed to be 
at the origin. The object's starting position is defined by a vector p (note that the 
length of p is the circle's radius) and the plane containing the circle has a unit normal 
a (Figure 25). If the object is rotated by an angle 9 then the new position is 

pnew = (1 - cos#)(a •p)a + p COS0+ sin0(a x p) (A.4) 

Axis of rotation 

Initial position 

Figure 25: Definition of parameters for circular motion. 
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Appendix B: Raw Data File Formats 

Although the majority of users of this toolbox will not need to know the exact format 
of the raw radar data files, the fact that a number of different formats exist means that 
the user should be aware of the differences. Below is a brief list of the more recent 
formats used by Surveillance Systems Division, the description used to select the 
format in the ISARLAB interface and the time period they were mostly in effect. 
Information in the file header, or the creation date of a given data file, should enable 
one to determine the file format that should be used when extracting the desired data 
segment. 

Radar Van Formats (these are all stepped frequency waveforms): 

Prior to 9/89: Not implemented in this system. 

Van: fixed header, fO format (9/89 - 1/91): These files have a 256 byte fixed 
length header followed by IQ pairs of received data only. The number of 
frequency steps per sweep is either 146 or 292. The corresponding number of 
sweeps is 128 or 256. The peculiar number of steps arises because the initial 
frequency, fO, is repeated after every seven steps. These fO values are stripped 
from the data prior to processing. 

Van: fixed header format (2/91 - 9/91): As above but without the flXs and 
with the possibility of more than 256 sweeps per record. 

Van: variable header format (10/91 - date): These files have a variable length 
header followed by transmitted and received IQ data, with sweeps separated by a 
48 byte intersweep header. The main header is terminated by a AZ character (1A 
hex). The number of sweeps in a record can be very large. There can also be 
attenuation changes in the data at predefined intervals (typically 512 sweeps). 
Information on any such changes is contained in the intersweep headers. 

AuSAR format: These files are 8-bit integer binary data of IQ pairs representing 
received, analogue range compressed and sampled linear FM (chirp) data. There is no 
header or other auxiliary information in the file. 

INGARA format: These files are 32-bit floating point format binary data of IQ pairs 
representing received, sampled and digitally range compressed linear FM (chirp) data. 
There is no header or other auxiliary information in the file. 
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Appendix C: Units 

The internal representation of all quantities in the system and the units used in the 
graphical user interface are as follows: 

Table 4: Units used internally and in the graphical user interface. 

Quantity Internal Units Units seen in the interface 

Length Metres Metres 
Time Seconds Seconds, Microseconds 
Frequency Hertz Hertz, MegaHertz, GigaHertz 
Angular Measure Radians Degrees 
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Appendix D: Troubleshooting 

The following are some of the more common problems found when trying to form 
images with ISAR processing. 

Problem: 
Possible Cause: 
Solution: 

Problem: 
Possible Cause: 
Solution: 

Problem: 
Possible Cause 1: 
Solution 1: 
Possible Cause 2: 
Solution 2: 

Image is squashed onto zero Doppler 
Insufficient relative motion between radar and target 
Modify scenario appropriately 

Image is aliased in Doppler 
Under sampling 
Modify the signal to make the PRF higher 

Poorly focussed image 
Motion compensation should be applied 
Modify the processing options to include motion compensation 
Incorrect Data Format selected (Trial mode only) 
Read data again with the correct format from the File import 
menu 
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